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Introduction
File Manager Jr. gives you rapid access to files in all your favorite folders.  The 
program makes it easy to open, move, copy, delete, rename and print documents, 
and to perform many other operations.

Before using File Manager Jr. to gain access to a folder, you need to identify the 
folder so the program will be able to find it.  This is a one-time operation.  Once 
the folder is identified, its files are readily accessible.  For more information, see 
Assigning folder names on page 4.

Q.   Why use File Manager Jr. when you can use the Windows Explorer to 
perform many common file-management operations?

A.   Explorer is not built into Word for Windows.  It’s a separate program 
designed to serve multiple Windows applications.  If you’re working on a Word 
document and you want to use Explorer, you must leave Word.  File Manager Jr. 
is different.  The program in effect becomes part of Word , so you don’t have to 
go somewhere else to find it.  If you spend much of your time using Word, and 
perform more than a few file-management operations in a typical work session, 
you’ll find File Manager Jr. a handy alternative to Explorer. 

To illustrate, suppose that you want to use Explorer to delete a file in the folder 
C:\MSOFFICE\WINWORD\REPORTS.  First you’ll need to use the Taskbar to switch 
from Word to Explorer (assuming Explorer is running).  If the WINWORD folder is
not visible in Explorer, you’ll need to display the folder name by clicking the plus
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sign next to the MSOFFICE icon.  If the names of your WINWORD subfolders are not
visible, you’ll need to click the plus sign next to the WINWORD icon.  Then you’ll 
need to find the REPORTS folder and click the name of the file you want to delete. 
Then you'll need to drag the file to the Recycle Bin or choose Delete from the 
File menu.  Then you’ll need to use the Taskbar to switch back to Word.

Using File Manager Jr. to perform the same operation, you would:

1. Click the Delete command button.

2. Double-click a name in the File Manager Jr. Folder box.

3. Double-click a filename.  Job done.

Trying before buying
This is an evaluation copy of File Manager Jr.  It gives you access to the 
program’s basic file-management commands, but not to all commands.  You may 
use this trial copy for 30 days to get the feel of the software.  If you want to keep 
using File Manager Jr. after the 30-day trial period, you must purchase a 
registered copy of the program.  If you do so, you get a bonus package of Word 
macros designed to speed up your work..

For information about ordering a registered copy—and getting access to all the 
File Manager Jr. commands—see page 15.

Conventions used in this guide
Generally, names of  files and folders appear in small capitals.  Examples of 
words to be typed by the user appear in bold, usually uncapitalized.

Command buttons in dialog boxes are sometimes referred to simply as 
“commands.”  

In typing instructions, the plus sign and comma have special meanings when used
between names of keys.  A plus sign (as in Alt+B) means that the first key is to be
held down while the second key is pressed.  A comma (as in Tab, H) means that 
the first key is to be pressed and released before the second key is pressed.

Starting the program
To make it easy to start File Manager Jr., you should assign the program to a 
shortcut key and/or toolbar button.  (Step-by-step directions are found on page 
13.)



When you start the program, you see the main menu.  One column of commands 
appears on the left and another on the right.  A Folder box appears at the center.  
The names in the Folder box are faintly visible (as seen in the following 
example).

If you select a command in the left-hand column, the names in the Folder box 
come into sharp focus (as illustrated below).  You can then choose the folder in 
which you want to carry out the command you have selected.

Commands in the right-hand column are enclosed in a free-standing box and 
operate independently, making no use of the Folder box.  Most commands in the 



right-hand column are available only to users with the full program.



Assigning folder names
The first time you start File Manager Jr., the name “Main Word Folder” appears 
alone in the Folder box at the center of the main menu.  To gain access to folders 
other than the main Word folder, you simply tell the program which additional 
folders you want access to.  Procedure:
Starting at the main menu, choose the Setup button and then the Assign Folder 
Name button.  In the Assign Folder Name box, type a full folder path.  Example: 
d:\martha\memos.  The folder can be on any hard drive.

After entering the path, press the Tab key to move to the lower part of the Assign 
Folder Name box.  Type a brief descriptive name for the folder you’re assigning. 
Example: martha’s memos.  Then press the Enter key.  The program records the
folder assignment and redisplays the main menu.  The descriptive name of the 
folder you have just assigned appears in the Folder box.  

Note   Typing a descriptive name in the Assign Folder Name box is not 
obligatory.  After entering a full folder path, you can choose OK to close the box 
without typing anything else.  If you do so, the program treats the folder path as a
descriptive name and displays that path in the Folder box on the main menu.  
Suggestion: Don’t omit descriptive names, especially if you’re assigning folders 
with long paths.  A short descriptive name like “Jamison Project” is easier to read
than a path like “C:\Msoffice\Winword\Projects\Jamison.”

After assigning one folder, you can assign another.  Just choose the Setup button 
and then the Assign Folder Name button.  You can assign any number of folders. 
If the number runs to 100 or more, the program will start somewhat more slowly 
than it would if there were only a few dozen names in the Folder box.

The descriptive name of the main Word folder always appears at the top of the 
Folder box.  Names of the folders you assign are arranged alphabetically below 
the name of the Word folder.  For uniformity, the program capitalizes the first 
letter of each word in each descriptive name.  (You don’t need to use capitals 
when you type descriptive names in the Assign Folder Name box.)

If you want to remove a descriptive name from the Folder box, choose the Setup 
button and then the Remove Folder Name button.  Follow the onscreen directions.
Running the Remove Folder Name command does not delete a folder.  It merely 
clears a name from the Folder box.  If you no longer need access to a folder, you 
can use the command to discard the folder’s descriptive name.

If you want to change a descriptive name, choose the Setup button and then the 
Change Folder Name button.  If you discover a typing error in one of your 
descriptive names, you can use the Change Folder Name command to correct the 
error.  You can also use the command to replace a descriptive name if you think 
of a more suitable name.



Note   If your computer is connected to a network, you may be able to use File 
Manager Jr. to gain access to folders on network drives—just as you gain access 
to folders you’ve created on local drives.  It may not be possible, however, to use 
certain File Manager Jr. commands on network drives.  Your network privileges, 
for example, may not extend to deleting or renaming files in some folders.

Performing common operations
Mouse   To open a file,  click the Open button on the left side of the main menu 
and then double-click a descriptive name in the Folder box.  A file list appears.  
Double-click a filename.

To move, copy, delete, rename or print a file, first click the appropriate command
button in the left-hand column.  Then choose a descriptive name just as you 
would if you were opening a file.

Keyboard   To open a file, first select the Open button by typing the letter O.  
Then choose a descriptive name in the Folder box by highlighting the name and 
then pressing the Enter key.  A file list appears.  Highlight a filename and then 
press Enter.

To move, copy, delete, rename or print a file, first press a letter key to select the 
appropriate command button in the left-hand column.  Then choose a descriptive 
name just as you would if you were opening a file.

General   If you select a command button in the left-hand column and discover 
that you picked the wrong button, you can reselect.  Example: If you select the 
Delete button when you meant to select the Copy button,  just click Copy.  Or 
press Alt+C or Tab, C.  Alternatively, you can click the Home button to restart 
the program.  To choose the Home button using the keyboard, press Alt+H or 
Tab, H.

If the Folder box contains dozens of descriptive names and the name you want is 
buried in the list, try this: After selecting a command button in the left-hand 
column, type the first character of the descriptive name you’re looking for.  Then 
tap the down-arrow key once.  The first name beginning with the character you 
typed will be highlighted in the Folder box.  The name you want should then be 
within easy reach.

If you try to gain access to a folder that has been deleted, renamed or moved, a 
message informs you that the folder cannot be found.

To gain access a file in drive A or drive B, select a command in the left-hand 
column and then choose a drive button.  To choose the Drive A button using the 
keyboard, press Alt+V or Tab, V.  To choose the Drive B button, press Alt+E or 
Tab, E.



To run one of the commands in the column on the right side of the main menu, 
simply click a button or press a letter key.  Example: To run the Address List 
command, click the Address List button or press the A key.

Back buttons appear in many File Manager Jr. dialog boxes.  Choosing a Back 
button takes you back one step, closing a dialog box and redisplaying the 
previous box.  To choose a Back button using the keyboard, press Alt+B or Tab, 
B.

Note    For brevity, most step-by-step examples found later in this guide omit 
keyboard directions.  Such directions appear only when procedures used to 
perform keyboard operations have not been covered by earlier examples or when 
using the keyboard is clearly simpler than using the mouse.  File Manager Jr. 
often uses “choose” to mean that you can use either the mouse or the keyboard to 
carry out an action.  Examples: You can choose OK by clicking the OK button or
by pressing the Enter key.  You can choose a descriptive name in the Folder box 
by double-clicking the name or by highlighting the name and then pressing Enter.

The command list
Open   The command opens a previously saved file.

You can also use the Open command to see which files are in a given folder.  
After viewing the file list, click Cancel or press the Esc key to close the Open File
box.

Move   The command transfers a file from one folder to another.  It can also be 
used to move a file to or from a disk in a floppy drive.

Procedure: Select the Move button and then choose a descriptive name in the 
Folder box.  In the next box, choose the name of the file you want to move.  A 
Destination box appears.  Choose a destination.

To move a file to drive A or drive B, choose the appropriate drive button in the 
lower part of the Destination box. 

Copy   The command creates a duplicate of a file and sends the duplicate to a 
destination of your choice, leaving the original copy of the file in place.  The 
Copy command is structurally similar to the Move command.

Delete   The command deletes a file.  By default, File Manager Jr. does not ask 
for confirmation before executing the command.  If you want to be asked, choose 
the Setup button on the main menu and then choose the File Delete Confirmation 



button.

Note    You can restore files deleted with the Delete command.  For more 
information, see Trash Bin later in this guide.

Kill Backups   The command deletes backup files in one or more folders.  
Procedure:

Select the Kill Backups button and then choose a descriptive name in the Folder 
box.  A new box identifies the target folder (the folder associated with the 
descriptive name) and gives you a choice:  You can delete backup files in the 
target folder only.  Or you can delete backups in the target folder and in any 
subfolders of the target folder.

Before using the command, close any open backup files.

Kill Backups does not delete backup files on floppy disks.  When you select the 
command, the Drive A and Drive B buttons are unavailable.

Rename   The command changes the name of a file.  When asked to enter a new
name for a file, do not type a folder name or subfolder name ahead of the 
filename.  Type the filename only.  Example: baker.doc.  (If you type a filename
without a one-to-three-character extension, the program adds a .DOC extension.)

A filename is invalid if it contains an asterisk, colon, quotation mark, question 
mark, angle bracket (<  or  >), slash ( / ), backslash ( \ ) or pipe symbol ( | ).

Print File   The command allows you to print documents without opening them. 
You can print any document in any folder identified by a descriptive name in the 
Folder box. After choosing a document to print, you can elect to print one copy of
the complete file, or to print multiple copies, or to print only certain pages.

Save New   The command is used to specify where a file will be stored when 
saved for the first time.  Example: If you have a new file onscreen and want to 
store it in the main Word folder, select the Save New button and then double-
click the descriptive name of the Word folder at the top of the Folder box.  When 
asked to enter a name for the new file, don’t type a path ahead of the filename.  
Type the filename only.  Example: dock.doc.  (If you type a filename without a 
one-to-three-character extension, the program adds a .DOC extension.)

The command cannot be used to store a new file on a floppy disk.  When you 
select the Save New button, the Drive A and Drive B buttons are unavailable.



Get Stats   The command displays statistical information about files in a 
specified folder.  Procedure: Select the Get Stats button and then double-click a 
name in the Folder box.   A dialog box displays a list of the files in the selected 
folder.  To view statistical information about the first file in the list, double-click 
the name of that file.  To view statistical information about another file, double-
click another name.

Back Up   The command sends a copy of the active document to a backup disk 
in the A drive.  Any previous backup copy is overwritten.

If you have a B drive and want to use that drive for backups instead of the A 
drive, choose the Setup button and then the Change Backup Drive button.

Print Selection   The command prints a selected block of text.  First highlight 
the text you want to print.  Then choose the Print Selection button.

File Info   The command displays a word count, a page count and other 
statistical information about the active document.

New Folder    The command creates folders.  First choose the New Folder 
button and then type the full path of the folder you want to create.  Example: c:\
sales reports.  After entering the path, press Enter.

You can create a folder and one or more levels of subfolders at the same time.  
Example: If you type c:\docs\articles and then press Enter, the command creates 
a C:\DOCS folder and a C:\DOCS subfolder called ARTICLES.  (If the C:\DOCS folder 
already exists, only the ARTICLES subfolder is created.)

Address List   The command gives you access to a list of addresses.  You can 
use the command, for example, to copy addresses to letters and envelopes.  For 
additional information, see More about Address List later in this guide.

Junk Closet   The command is used to store text temporarily in a holding file 
or to retrieve text from the holding file.  For additional information, see More 
about Junk Closet later in this guide.

Quit Word   The command closes any open files and shuts down Word.  If any 
open  files have been changed since they were last saved, the changes are 
preserved.  If you have entered text in a new document but have not yet named 
the document, you’ll be asked to supply a name before quitting Word.



Trash Bin
Overview: Using the File Manager Jr. Delete command, you can delete files from
within Word instead of having to leave the program to delete them.  When files 
are deleted from within Word, Windows 95 does not provide backup protection 
by sending the files to the Recycle Bin.  But File Manager Jr. allows you to 
protect such files by having them sent to a Trash Bin folder.  

If you don’t want to use the Trash Bin feature, skip the rest of this section, 
bearing in mind that files deleted with the Delete command may then be 
irretrievable.

To create a Trash Bin folder that will protect deleted files, do this:

Starting at the main menu, choose the Setup button, then the Trash Bin button, 
then the Create Trash Bin button.  Enter a path identifying the folder in which 
you want to keep deleted files.  Example: c:\trashbin.  If the folder doesn’t exist,
File Manager Jr. can create it.  The folder can be on any hard drive.

When you delete a file, it is sent to the Trash Bin with an extended name that 
includes the date and time of the deletion.  A 24-hour time format is used.  
Examples: The date is August 1, 1996.  At 3:10:05 p.m. (or 15 hours, 10 minutes 
and 5 seconds on the 24-hour clock), you delete a file called BLUTO.DOC.  The file
is sent to the Trash Bin as BLUTO.DOC  08-01-1996  15 10 05.  The following day, at 
9:06:03 a.m., you delete another file called BLUTO.DOC.  That file is sent to the 
Trash Bin as BLUTO.DOC  08-02-1996  09 06 03.

You can quickly restore a deleted file.  Procedure: On the main menu, choose the 
Trash Bin button.  Then choose the Restore button.  A list of Trash Bin files 
appears.  Double-click the name of the file you want to restore.  A Destination 
box appears.  Choose a destination.  You can place the file in any folder identified
by a descriptive name in the Destination box.  Or you can  send it to a floppy 
disk.  When a file is restored, the date-and-time stamp is removed from the 
filename.

The Trash Bin does not capture files deleted with the Kill Backups command.

You can discard Trash Bin files when you know you’ll have no further use for 
them.  First choose the Trash Bin button and then choose the Discard button.  
Files can be discarded individually or all at once.  Directions appear onscreen.

If you’ve set up a Trash Bin folder and no longer wish to use it, choose the Setup 
button, then the Trash Bin button, then the Remove Trash Bin button.  Do not use
any other method to remove the Trash Bin.

More about Address List
When you choose the Address List button, a dialog box displays seven command 
buttons.  The first button is Add Listing.

The Add Listing command is used to create address listings and add them to a file



in which frequently used addresses are stored.  (The file is called NAMELIST.FMJ.  
It 

is placed in the main Word folder during installation of File Manager Jr.)  When 
you choose the Add Listing button, an empty address box appears.  You type 
information in the box.  Here is an example of a completed box:

If you want to use a courtesy title such as “Ms.” or “Mr.,” place the title ahead of 
the first name.  In the Horatio Blunt address listing illustrated above,  “Mr. 
Horatio D.” could have been typed in the FirstName field in place of “Horatio 
D.”

If you want to use a middle name or middle initial, just add it to the FirstName 
field.  See the FirstName field in the Horatio Blunt listing.

If you want to use an abbreviation such as “M.D.,” “Esq.” or “Jr.” after an 
addressee’s name, place the abbreviation at the end of the LastName field.  See 
the Horatio Blunt listing.

You can skip some fields.  Example:  If you want to record a company address 
rather than the address of an individual, skip the first two fields and type the 
company name in the Organization field.

If a listing includes a Salutation field, the text entered in that field is used as part 
of a salutation when the listing is copied to a letter.  The Horatio Blunt listing, for
example, would be copied with a “Dear Mr. Blunt:” salutation.  If “Horatio” had 
been typed in the Salutation field instead of “Mr. Blunt,” the address would be 
copied with a “Dear Horatio:” salutation.

The Phone&Misc field is used to store telephone numbers and miscellaneous 
information.  The field accommodates about 250 characters.



The second command in the Address List dialog box is Copy Address.  It places 
an address block in a business letter, saving you the trouble of typing an inside 
address.  To copy an address block, first place the insertion point anywhere on the
top line of the body of your letter.  Choose the Address List button and then the 
Copy Address button.  When a new box appears, type a last name, a first name or 
some other combination of characters known to be in the listing you’re looking 
for.  Then press Enter.  The program searches for a listing containing the 
characters you typed.  If the first listing found is not the one you want, choose the
button labeled Skip This Listing.  The program then searches for a second listing 
containing the characters you typed. (It is of course helpful to avoid typing a 
sequence of characters likely to be found in many listings.)

The third command in the Address List dialog box is Print Envelope.  It works 
much like the Copy Address command.  Have an envelope ready to print when 
you run the command.

By default, the Print Envelope command uses the Courier New font and does not 
print a return address on envelopes.  To override either or both defaults, do this: 
On the main menu, choose the Setup button.  In the Setup dialog box, choose the 
Envelope Format button.  Select a font and a point size.  When asked whether you
want a return address printed, choose the Yes or No button.  If you choose Yes, 
Word will use whatever address it finds in your Mailing Address box.  To see 
what’s in that box, first display the Tools menu in Word.  Choose Options. Then 
choose the User Info tab.

The fourth command in the Address List dialog box is Delete Listing.  Use it 
when you want to remove a listing from the address file.  After choosing the 
Delete Listing button, enter a name just as you would if you were using the Copy 
Address or Print Envelope command.  Then press Enter.

The fifth command, View Listing, is used to look up information in an address 
listing.  Example: If you need Horatio Blunt’s street address, telephone number 
or fax number, choose the View Listing button and type horatio in the next box.  
Then press Enter.

The sixth command, View All Listings, is also used to look up information.  
Unlike the previous command, which displays a single address record, the View 
All Listings command displays a file containing all your address listings.  After 
viewing the listings, you can close the file as you would any other—by choosing 
Close on the File menu or by clicking the lower of the two X buttons at the top 
right corner of the screen.

If you add a listing or otherwise change the address file, the View All Listings 
command will take longer to run the next time you use it.  But after that it will 
run at full speed until the address file is changed again.

The last command in the Address List dialog box is Fix Listing.  If you discover a
typing error in one of your listings, you can use the Fix Listing command to 
correct the error.  (Do not try to correct a listing by editing the NAMELIST.FMJ file.
You can open NAMELIST.FMJ to view its contents, but you can’t edit the file and 



then save it.  If you try, a message informs you that NAMELIST.FMJ is a read-only 
file.  Should that message appear, press Esc twice and then close the file.)

A fictitious Horatio Blunt listing has been placed in the File Manager Jr. address 
file for demonstration purposes.  If you have the full program, you can use the 
Horatio Blunt listing to experiment with the Copy Address command, and also 
with the Print Envelope, View Listing, Fix Listing and Delete Listing commands.

Caution   If you created an address list with a pre–Word 95 version of File 
Manager Jr., that list was preserved when you installed File Manager Jr. 95.  But 
the list must be reformatted before you attempt to use it with the new version of 
the program.  See the READ_1ST.TXT file in the main Word folder.

More about Junk Closet
The Junk Closet command is used to set aside text you want to remove from the 
active file but keep available for possible use later.

To store a block of text in the junk closet, highlight the text, choose the Junk 
Closet button and then choose the Store Selection button.  The text is removed 
from the active document and sent to a file called JUNK.FMJ.  (The file is placed in
Word’s main folder when you install File Manager Jr.)

To find text in the junk file, choose the Junk Closet button and then the Open 
Closet button.  A Find box appears.  Type a word or phrase peculiar to the block 
of text you’re looking for.  Then press Enter.  If the junk file is small and you 
don’t need to run a search, press Esc to close the Find box.

To retrieve a block of text from the junk file, highlight the text and place it on the
Windows Clipboard.  Then close the junk file and paste the text into the active 
file.

Separator marks appear between blocks of text stored in the junk file so that you 
can easily tell where one block ends and the next begins.

To delete text from the junk file, open the junk closet, highlight the text you want
to delete and press the Delete key.  Then save and close the file.

File Manager Jr. and the Windows Clipboard
Occasionally, File Manager Jr. may clear the Clipboard while executing a 
command.  The Clipboard may be cleared because the program needs to use it for
storage and retrieval of data while a command is running.  Or, infrequently, it 
may be necessary to clear the Clipboard to keep Word from misreading the status 
of a file.  You can still use the Clipboard for normal cut-and-paste operations.  
But if you cut a block of text and then run a File Manager Jr. command without 



first pasting the block somewhere, the deleted text may no longer be retrievable.

Assigning File Manager Jr. to a shortcut key
1. On the Tools menu, click Customize.

2. In the Customize dialog box, click the Keyboard tab (at the upper right).

3. In the Categories list box, click Macros.

4. In the Macros list box (to the right of Categories), click the name FileMgrJr.

5. Click the box labeled Press New Shortcut Key.  Press a key or combination of
keys.  Example: If you want File Manager Jr. to start when you press 
Alt+J , hold down the Alt key and then type J.

6. Click Assign.

7. Click Close.

Note   When File Manager Jr. is installed, it is assigned to a special shortcut key 
(Alt+Ctrl+Shift+Backspace).  That key performs an internal function and should 
not be removed.  It won’t interfere with your own File Manager Jr. shortcut key.

Assigning File Manager Jr. to a toolbar button
1. On the Tools menu, click Customize.

2. In the Customize dialog box, click the Toolbars tab (at the upper left).

3. In the Categories list box, click Macros.

4. In the Macros box (to the right of Categories), click the name FileMgrJr. and 
keep the left mouse button depressed.  A rectangular outline appears.  
Drag the outline to a position on the toolbar and then release the mouse 
button.

5. In the box labeled Text Button Name, type a short name for the toolbar 
button.

6. Click Assign.

7. Click Close.

Starting File Manager Jr. automatically
If you want the File Manager Jr. menu to appear whenever you start Word, 
choose the Setup button on the main menu and then choose the AutoMenu button.
In the AutoMenu box, choose the Enable button.  If the AutoMenu feature is 
switched on and you want to switch it off, choose the Disable button.



Uninstalling File Manager Jr.
1. In the main Word folder, delete JUNK.FMJ, LICENSE.FMJ, NAMELIST.FMJ, 

READ_1ST.TXT and TUTOR.FMJ.

2. In the folder where Word templates are stored, delete FMJ.DOT. 

3. On the Tools menu, click Macro.  In the macro list box, delete all macros with
names containing the characters “FileMgrJr.”
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Ordering information

Mail orders   To replace this evaluation copy of the program with a fully 
licensed  version, fill out the form below.  

* * * * * * * * * * * * * * * * * * * * * * * * * * * *
*                                                     *
*               ====================                  *
*               O R D E R    F O R M                  *
*               ====================                  *
*                                                     *
*   Please send one copy of File Manager Jr. 95 to:   *
*                                                     *
*   NAME:    ______________________________________   *
*                                                     *
*   ADDRESS: ______________________________________   *
*                                                     *
*            ______________________________________   *
*                                                     *
*            ______________________________________   *
*                                                     *
*   I enclose $19.95, plus $2.00 for shipping and     *
*   handling ($4.00 S&H outside U.S. and Canada).     *
*                                                     *
* * * * * * * * * * * * * * * * * * * * * * * * * * * *

Mail your order to Charles Maher, 409 North 18th Street, Coeur d’Alene, ID 
83814-5460.

Credit-card orders   MasterCard, Visa, American Express and Discover cards 
are accepted.  To order, call Public (software) Library at 800-242-4775.  Ask for 
item 14432.  Operators are available from 5 a.m. to 4 p.m., PST, Monday through
Thursday, and from 5 a.m. to 10:30 a.m., PST, on Friday.  You can also place an 
order with Public (software) Library by fax (713-524-6398) or by  e-mail 
(71355.470@compuserve.com).  Note: These numbers are for credit-card orders 
only.  They cannot be used to reach the author of the program or to get 
information about the program.

To place a credit-card order by U.S. mail, send a completed order form and 
credit-card information to Public (software) Library, P.O. Box 35705, Houston, 
TX, 77235-5705.

You can also place a credit-card order on CompuServe.  Type GO SWREG.  The 
CompuServe Registration ID for File Manager Jr. is 5059.    

Questions about the program or about the status of an order should be directed to
the author.  He can be reached by phone (208-664-3864), by fax (208-664-9743) 
or by e-mail (76476.3400@compuserve.com).
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